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 PowerPoint 2019

Take Off  (Page no. 11)

1. T 	 2. T	 3. F	 4. F	 5. T

Double Tap (Page no. 14)

1. Remove button
2. Rotate left button
3. Increase brightness button
4. Decrease contrast button
5. Rotate right button
6. Decrease brightness button

	 Choose the correct option.

1. a. 	 2. a.	 3. b.	 4. c.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 
4. (This question was printed incorrectly in the book, please correct this question in your textbook).
  Question.
  The Pause button is used to temporarily the screen recording. 
  Ans. 

A
Q 	 Answer the following questions:

1.	� Insert button in Photo Album dialog box is used to insert pictures into the photo album.
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2.	� The Ink Equations feature of the PowerPoint is used to write equations using finger or stylus 
(in case of touch screen) and mouse pointer (in other devices).

3.	� Annotations are the comments and observations added by the presenter on the text / images 
forming part of the presentation.

	� To add annotations on a presentation, follow these steps: 
	 Step 1: Click on the Slide Show tab. 
	 Step 2: Check the Use Presenter View option. 
	� Step 3: �Start the slide show using From Beginning or From Current Slide tools to start the slide 

show.
	 Step 4: Click on Pen button to choose Pen from the pop-up menu.
4.	 The steps to use Smart Lookup feature in PowerPoint are:
	� Step 1: �Click and drag the mouse pointer to select the word/phrase for which the meaning is to 

be searched. 
	 Step 2: Right-click on the selected text/phrase.
	 Step 3: Click on the Search ‘<selected text>’ option to make a smart search.

	 Scratch Your Brain.

1.	 a. Screen Recording	 b. Ink Equations	 c. Photo Album	 d. Ink Annotations
2.	 Competency-based/Application-based questions:
	 a. I will ask Rohan to follow the steps given below:
	   Step 1: Click on the Insert tab.
	   Step 2: Click on the Photo Album tool from the Images group.
	   Step 3: Click on the File/Disk button.
	   Step 4: Click and select the photographs to be added to the photo album.
	   Step 5: Click on the Insert button.
	   Step 6: Click on the Create button.
	 b. Geeta can use Ink Equations feature of PowerPoint.

 More on Excel 2019

Take Off  (Page no. 22)

a. 4 rows and 4 columns

b. 300	 c. 109	 d. B4 and C3	 e. D4

2.
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Double Tap (Page no. 26)

a. F 	 b. T

	 Choose the correct option.

1. d. 	 2.  c.	 3.  a.	 4.  b.	 5. a.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1. 	 2. 	 3. 	 4. 

	 Fill in the blanks with the correct words.

1.  Insert	 2. Cell Styles	 3. Select All	 4. Merge & Center 

A
Q 	 Answer the following questions:

1.  �Copy command is used to copy content at the new place and it also exists in its original place.
2.  �Wrap text feature of Excel allows us to add multiple lines of text inside a cell.
3.  �Steps to wrap text inside a cell are:
   Step 1: Click the cell in which you want to wrap the text. 
   Step 2: Click on Home tab. 
   Step 3: Click on Wrap Text command.
4.  �The steps to change the row height are:
   Step 1: Select the column(s) or row(s) whose width or height you want to change. 
   Step 2: Click on Home tab. 
   Step 3: Click on Format command. 
   Step 4: Choose Row Height. 
   Step 5: Type the value that you want your row to be. 
   Step 6: Click on OK button.
5.  The steps to apply cell border are:
   Step 1: Select the cell or range of cells where you want to apply borders. 
   Step 2: Click on Home tab. 
   Step 3: Click the arrow next to Borders command. 
   Step 4: Click on the border style you would like.
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	 Scratch Your Brain.
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2.	 Competency-based/Application-based questions:
	 a. Sonia can use Merge cell feature of Excel.
	 b. Anaya can insert a row or column to enter those marks.

Periodic Assessment–1
(Based on chapters 1 to 2)

A.	 Define the following:
	 1. AutoFill:
	 �  AutoFill feature automatically fills a series of data in your worksheet. It saves your time to 

complete the text or number series for you.
	 2. Ink Annotations:
	 �  Annotations are the comments and observations added by the presenter on the text / images 

forming part of the presentation. This helps the presenter to highlight and emphasize on the 
important points while giving a presentation.

	 3. Merging Cells:
	 �  While working on Excel you might need to combine some cells to show a part of data under 

one heading. Combining two or more cells is known as merging.
	 4. Photo Album:
	 �  The Photo Album feature of PowerPoint allows the user to create a slide show or presentation 

using the photographs or image files selected by the user. The Photo Album may be created 
for personal or professional use.

B.	 Write the correct order of steps for removing cell borders.
	 3. Select no border option.
	 2. Go to the font group in the home tab.
	 1. Click the arrow next to Borders command.
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C.	 Identify the icons and write their features.
	 1. �Photo Album: the Photo Album feature of PowerPoint allows the user to create a slide show 

or presentation using the photographs or image files selected by the user.
	 2. �Screen Recording: powerpoint 2019 allows the user to record the action on the screen alongwith 

the audio and embed the recording into the pwerpoint presentation.
	 3. �Ink Equations: the Ink Equations feature of the PowerPoint allows the user to write equations 

using finger or stylus (in case of touch screen) and mouse pointer (in other devices). 
	 4. �Stop Button: stop button is used to stop the screen recording and embed the recoded video 

into the slide.

 Charts, Formulas and Functions in Excel

Take Off  (Page no. 36)

Average marks are 90 and Percentage in the exams are 90%.

Double Tap (Page no. 37)

1. T 	 2. T	 3. F

Double Tap (Page no. 46)

  a. 5	 b. Comp	 c. 7
  d. CURRENT SYSTEM DATE WILL BE DISPLAYED
  e. 5 	 f. 3

	 Choose the correct option.

1. a. 	 2. a.	 3. b.	 4. c.	 5. d.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 	 5. 

	 Fill in the blanks with the correct words.

1. Functions	 2. equal	 3. square root	 4. dollar($)	 5. MIN()

3.
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A
Q 	 Answer the following questions:

1. A cell reference is a cell address that can be used in a formula to denote a specific cell.
2. SUM() returns the sum of a range.
3. Text functions are used to work on the characters entered as text.
  Two Mathematical functions are:
  Mod(number, divisor)– It returns the remainder after a number is divided by the divisor.
  Sqrt(number)– It returns the square root of the given number.
4. �IF Function checks whether the given condition met, and returns value1 if the condition evaluates 

to true, and returns value2 if the condition evaluates to false.  
  For example: 
  Percentage = 80 Input: =IF(Percentage >= 50, “Passed”, “Failed”) 
  Output: Passed
5. The rules to enter a function are:
  a. All Excel functions must begin with = sign. 
  b. Function name must be a valid Excel name. 
  c. Function must be followed by opening and closing parenthesis.
  d. Most of the functions must contain an argument within it.

	 Scratch Your Brain.
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2.	 Competency-based/Application-based questions:
	 a. Siya should use SUM Function.
	 b. I will tell Alisha to use Date and Time Function.

 Introduction to Adobe Animate

Take Off  (Page no. 51)

Do it yourself.

Double Tap (Page no. 57)

1. Stage	 2. Tools Panel	 3. Pencil	 4. Gradient	 5. Menu Bar

	 Choose the correct option.

1. a		 2. d	 3. b	 4. c	 5. a

	 Fill in the blanks with the correct words.

1.  Animation	 2.  blank	 3.  Stage 	 4.  Lasso	 5.  Lines

A
Q 	 Answer the following questions:

1.	 Properties Panel displays the different properties of the object, which is selected.
2.	 Gradient Fill is a combination of colours where one colour changes into another.
3.	 Keyframes are those frames where major changes take place in the animation.  
4.	 a.	 Selection tool is used to select objects on the stage for modification. 
	 b.	 Pen tool is used to draw lines and curves by creating a series of dots that are automatically 

connected.
	 c.  Free-transform tool is used to move, scale, rotate, skew, or distort objects.
5.	 To create a document in Adobe Animate, follow the given steps:
	 Step 1: Click on the File menu. 
	 Step 2: Select New option. 
	 Step 3: Type the desired dimensions and frame rate. 
	 Step 4: Select the desired Platform Type. (We have selected ActionScript 3.0 in the given example.) 
	 Step 5: Click on Create button.

4.
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6. To create a simple animation, follow the given steps:
Step 1: Draw three rectangles and fill different colours.
Step 2: Right click on the frame and select Insert Keyframe.
Step 3: Change the color of the rectangles using the Fill color option.
Step 4: Click on Control tab.
Step 5: Select Test option.

Scratch Your Brain.

1. Do it yourself
2. Do it yourself

3. 	 a. b. c. 

    Free Transform Tool	      Lasso Tool     Pen Tool

	 d. e. f. 
.

    Text Tool     Rectangle Tool	      Eraser Tool 

4.	

2. Competency-based/Application-based questions:
a. Save option
b. Pencil tool
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Periodic Assessment–2
(Based on chapters 3 to 4)

A.	 Read the clues and guess my name.
	 1. Cell reference 
	 2. (This question was printed incorrectly in the book, please correct it in your textbook.)
	     Question: I am main working area in Animate that is used while creating a project.
	     Ans: Stage 
	 3. Functions
	 4. Logical Function
	 5. (This question was printed incorrectly in the book, please correct it in your textbook.)
	     Question: I am a tool that creates an inclined blend of colours. 
	     Ans. Gradient
B.	 Label the following components of Animate window. 

	
C.	 Name the type of referencing used in the following and describe each type of referencing:
	 1. �Absolute References :	�If you wish to maintain the original references as they were, then you 

should make use of the absolute references.
	 2. Mixed References :	� A mixed reference is a reference that refers to a specific row or column. 

It is basically a combination of relative and absolute references.
	 3. Relative References:	� In relative reference, you actually refer to cell that is above or below 

and left or right to a number of rows or columns.
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Test Sheet–1
(Based on chapters 1 to 4)

A.	 Choose the correct option.
	 1. a.	 2. b.	 3. c.	 4. c.	 5. a.	 6. b.
	 7. b.	 8. c.	 9. d.	 10. d.	 11. b.	 12. c.
B.	 Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1. 	 2. 	 3. 	 4. 	 5. 	 6. 
	 7. 	 8. 
C.	 Answer the following questions:
	 1. �The Photo Album feature of PowerPoint allows the user to create a slide show or presentation 

using the photographs or image files selected by the user.
	 2. To create a photo album, follow these steps:
	   Step 1: Click on the Insert tab.
	   Step 2: Click on the Photo Album tool from the Images group.
	   Step 3: Click on the File/Disk button.
	 3. Copy command is used to copy content at the new place and it also exists in its original place.
	 4. Copy command is used to copy content at the new place and it also exists in its original place. 
	 5. SUM() returns the sum of a range. 
	 6. Text functions are used to work on the characters entered as text. 
	   Two Mathematical functions are: Mod(number, divisor), Sqrt(number).
	 7. Gradient colour is a combination of colours where one colour changes into another. 
	 8.	�To create a simple animation, follow the given steps:
		  Step 1: Draw three rectangles and fill different colours. 
		  Step 2: Right click on the frame and select Insert Keyframe. 
		  Step 3: Change the color of the rectangles using the Fill color option. 
		  Step 4: Click on Control tab. 
		  Step 5: Select Test option. 

 Introduction to HTML5 & CSS3

Take Off  (Page no. 71)

a. Home Page	 b. Website	 c. Hyperlink	 d. URL

5.
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	 Choose the correct option.

1.  a.	 2. b.	 3. a.	 4. b. 

	 Fill in the blanks with the correct words.

1.  Markup	 2. Head	 3. Block	 4. Empty	 5. Nesting

A
Q 	 Answer the following questions:

1.  �HTML stands for Hypertext Markup Language. It is a markup language that describes the structure 
of the web page.

2.  �The tags that have both opening and closing tags are called Container Tags. 
3.  �In case of external stylesheet, the CSS styles are written in a separate file which is saved with .css 

extension.
4.  �Rules for writing HTML tags are:
   a. Container tags should always be closed properly. 
   b. Values given to the attributes should be enclosed within the double quotes. 
   c. Tag name should not contain spaces. 
   d. There should be no spaces between < and > in a tag. 
   e. Tags must be nested correctly.

	 Scratch Your Brain.
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2.	 Competency-based/Application-based questions:
	 a. Ajit should use <HEAD> Tag to add headings to his web page.
	 b. I would suggest Anjali to use <TITLE> Tag to her web page.

 Internet Services

Take Off  (Page no. 83)

1. Facebook	 2. Twitter	 3. Instagram	 4. YouTube

Double Tap (Page no. 86)

1. Quora	 2. Twitter	 3. Facebook	 4. Skype

	 Choose the correct option.

1. a. 	 2. a.	 3. d.	 4. d.	 5. b.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 

	 Fill in the blanks with the correct words.

1. cash on delivery		  2. communicate, information
3. Facebook 	 4. blogger	 5. questions	 6. cloud storage

A
Q 	 Answer the following questions:

1. �Two things that you cannot share on Quora are:
  a. You cannot argue on any topic or raise a conflict. 
  b. You cannot promote business ideas or market your products.
2. Two risks of using cloud computing are: 
  a. Your sensitive data might be at risk from hackers. 
  b. Some people might face issues like data loss.
3. �Blog is a short form of WEBLOG, which refers to a website where new information about any topic 

is updated regularly.

6.
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  Two types of blogs are:
  a. Food Blog
  b. Travel Blog
4. �RSS feed fetches the updated web feed or newly published information from the website/blog 

directly to you. So, you do not have to search for updated information again and again.
5. �A blog is based on the idea of the orderly release of new content to attract a crowd, whereas a 

website is a collection of static pages such as the home page, the contact page, and the profile page.

	 Scratch Your Brain.

1. 	 	 	 	

	 Blogger	 OneDrive	 RSS Feed	 GooglePay

2.	 Competency-based/Application-based questions:
	 a. Shreya and her group can use Cloud Computing.
	 b. Rihan can use Facebook to get in touch with his classmates.

Periodic Assessment–3
(Based on chapters 5 & 6)

A.	 Write the missing part from the basic structure of an HTML document. 
	 TITLE 	 </HEAD> 	 </HTML>
B.	 Write the correct order of steps to save an HTML document.

	 2   Click on Save button to save the file.

	 3   Click on Save to open Save As dialog box.

	 4   Choose the location where you want to save the file. In this case, Desktop is selected.

	 5   Enter name for the file as ‘First Web Page.html’.

	 1   Click on File menu.
C.	 Give an example of the following:
	 1. (This question was printed incorrectly in the book please correct it in your textbook).
	     Question: Cloud Computing
	     Ans: Google Drive
	 2. Paytm
	 3. Debit Card 
	 4. Facebook
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	 5. (This question was printed incorrectly in the book please correct it in your textbook).
	     Question: Blogging
	     Ans: blogger.com 
D.	 (This question was printed incorrectly in the book please correct it in your textbook).
	 Question: Write the uses of the following: 
	 1. Text Level Tags
	 2. Empty Tags
	 3. Attribute 
	 4. Block Level Tags
	 5. Container Tags
	 Ans. 
	 1. The text level tags are used to mark up parts of the text. 
	 2. These Tags contain only opening tag. 
	 3. This is a property that provides some additional information about a tag.  
	 4. The block level tags take up the full width available and by default begin on a new line. 
	 5. The tags that have both opening and closing tags.

 Algorithmic Intelligence

Take Off  (Page no. 101)

Message: 
1 12 5 18 20 27 13 1 10 15 18 27 3 25 3 12 15 14 5
A L E R T M A J O R C Y C L O N E

Double Tap (Page no. 103)

1. b.	 2. c.	 3. d.	 4. e.	 5. a.

	 Choose the correct option.

1. �c. (The option of this question was printed incorrectly in the book, please correct it in your textbook 
(correct option is Parallelogram))

2. b.
3. (This question was printed incorrectly in the book, please correct this question in your textbook) 
  Question: Which of the following is not a problem solving technique? 

7.
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  a. Mind Map 		  b. Flowchart 
  c. Algorithm 		  d. None of these
Ans. d. 

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 	 5. 

A
Q 	 Answer the following questions:

1. �An algorithm is a set of steps in a sequential manner to solve a problem or to complete a task.
2. A flowchart is a type of graphical diagram that represents an algorithm.
3. Two symbols used in flowchart are:
  a. �Oval- It is used to show the start and stop points of the flowchart. It usually contains the words 

‘Start’ or ‘Stop’.
  b. Rectangle- It shows a process or action step.
4. Write an Algorithm to copy and paste a paragraph in Word:
  Step 1: Start.
  Step 2: Select the paragraph to copy.
  Step 3: Click on copy command or press Ctrl+C.
  Step 4: Click where you want to paste the paragraph.
  Step 5: Click on paste command or press Ctrl+V.
  Step 6: End.

	 Scratch Your Brain.

1. 

Yes

No

Stop

Start

Read Marks

Print "Fail"

Print "Pass"
Is 

Marks > 40?
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2.	 Competency-based/Application-based questions:
	 a. i. Parallelogram	 ii. Rectangle	 iii. Parallelogram
	 b. She should make an algorithm before drawing the flowchart.

 Introduction to Programming

Take Off  (Page no. 110)

1. T		 2. T	 3. T

Double Tap (Page no. 111)

1. BASIC	 2. PASCAL	 3. FORTRAN

	 Choose the correct option.

1. a. 	 2. b.	 3. a.	 4. b.

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 

A
Q 	 Answer the following questions:

1. �To communicate with the computers, we need some special languages which are called computer 
languages or programming languages.

2. High-level language is user friendly and easier to maintain. 
3. �A language translator is a software that converts a high-level language program into a machine 

language.
4. A low-level language is a programming language that is machine dependent.
  There are two types of low-level languages:
   i. �Machine Language : Machine language is the only language understood by the computer. It is 

also known as the first generation language (1GL). 
  ii. �Assembly Language: Assembly language is also known as second generation language (2GL). It 

is the language in which program codes are written in the form of alphanumeric symbols called 
‘Mnemonics’ instead of 0 and 1.

8.
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5. �The assembler enables the computer to convert the assembly language instructions into machine 
code, i.e., 0’s and 1’s, whereas compiler converts the entire high-level language program into 
machine language at once.

	 Scratch Your Brain.

1.	 Do it yourself.
2.	 Competency-based/Application-based questions:
	 a. Fourth Generation Language
	 b. Interpreter

 Python

Take Off  (Page no. 116)

1. �A low-level language is a programming language that is machine dependent, whereas High-level 
language is a programming language that enables a programmer to write programs that are 
machine independent.

2. Python is a high-level programming language.
3. Perl and JavaScript are programming languages that are similar to Python.

Double Tap (Page no. 121)

1. Python	 2. Interactive Mode	 3. Script Mode
4. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
  Question: I am an option to save the Python program. 
  Ans. Save option
5. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
  Question: I am an option to run the Python program.
  Ans. Run button 

Double Tap (Page no. 122)

9.
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	 Choose the correct option.

1. b 	 2. a	 3. d 	 4. d 	 5. d

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  	 2. 	 3. 	 4. 	 5. 

A
Q 	 Answer the following questions:

1. �Variables are memory reference points where we store values which can be accessed or changed 
later.

2. A data type specifies the type of value a variable can contains.
3. IDLE stands for Integrated Development and Learning Environment.
4. Hello! How are you?
5. a. 5	 b. 32782.0
6. a. �AND returns true, if both operands are true, whereas OR returns true, if one of the operands 

is true.
  b. �Modulus Operator divides left hand operand by right hand operand and returns remainder, 

whereas Division Operator divides left hand operand by right hand operand.
  c. �In Single-line Comment, a user wants to specify a single-line comment, then comment must 

start with the symbol #, whereas Python does not have a syntax for multi-line comments. To 
add a multiple-line comment, you could insert a # for each line.

	 Scratch Your Brain.

1.	 a. 2.0 
	 b. 12 
	 c. 10 20 30 
	 d. 6 
	 e. 4 True
2.	 a. print ("Sum is ", sum)
	 b. print('Orange Education') #Adding Value to Education
3.	 Do it Yourself. 
4.	 Competency-based/Application-based questions:
	 a. Sonam will use comment feature of Python. 
	 b. I will suggest him to use Interactive mode.
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	 Intelligence and AI Approaches

Take Off  (Page no. 134)

E A R P H O N E

Double Tap (Page no. 136)

Do it yourself.

	 Choose the correct option.

1. c. 	 2. b.	 3. a.	 4. b.

	 Fill in the blanks with the correct words.

1. interpersonal	 2. machine learning	 3. virtual assistant
4. intelligence	 5. Howard

	 �Tick ( ) the correct statements and cross ( ) the wrong ones.

1.  
2. (This question is printed incorrectly in the book, please correct it in your textbook.)
  Question: People with spatial intelligence cannot visualise things easily. 
  Ans.  
3. 
4. (This question is printed incorrectly in the book, please correct it in your textbook.)
 � Question: AI is the simulation of human intelligence processes through machines, especially 

computer systems. 
  Ans.  

A
Q 	 Answer the following questions:

1. These people possess the following qualities:
  • Good at dancing and sports
  • Love creating things with their hands

10.



Plus (Ver. 4.0)-VI (Answer Key)20

  • Tend to remember by doing, rather than hearing and seeing
  • Excellent hand-eye and physical coordination
  • Flexible in different body movements and performing actions
2. �A rule-based system uses rules as knowledge representation. These rules are coded in the system 

in the form of if-then-else statements which help the computer in taking decisions.
3. �Intelligence refers to the ability to think, to learn from previous experience, to solve complex 

problems and to adapt new things and environment.
4. �A computer system that achieves AI through a machine learning technique is called a learning-

based approach. This approach is often referred to as black boxes as it is not entirely clear how 
these systems take decisions. This is a major problem for applications when it comes to making a 
decision for investment, medical or military reasons as this approach remains unreliable.

5. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
  Question: Write about any four qualities of people with naturalistic intelligence.
  Ans. These people possess the following qualities: 
  • Nature lover 
  • Love exploring the environment and learning about other species 
  • Enjoy camping, gardening, hiking and exploring outdoors

	 Scratch Your Brain.

1.	 a. 82	 b. 141	 c. Plant
2.	 Competency-based/Application-based questions:
	 a. Naturalistic Intelligence
	 b. Interpersonal Intelligence 

Periodic Assessment–4
(Based on chapters 7 & 10)

A.	 Draw the flowchart symbols for the following:

	 	

	 	

	 	
B.	 State the use of these in Python. 
	 1. �Variables are memory reference points where we store values which can be accessed or 

changed later.
	 2. �In Python, operators can be defined as special symbols which perform arithmetic and logical 

computation.
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	 3. This takes the user’s input while a program executes.
	 4. This prints or sends the output to the standard output device, which is usually a monitor.
C.	 Mention any one quality of a person with the following intelligence: 
	 1. Have a deep and comprehensive understanding not just of the universe, but of the self.
	 2. Love exploring the environment and learning about other species
D.	 Write a Python program to calculate average marks of five subjects.
	� #To accept the marks of five subjects (out of 100) from the user and 

calculate the average.

	 a = int(input("Enter the marks in first subject: "))

	 b = int(input("Enter the marks in second subject: "))

	 c = int(input("Enter the marks in third subject: "))

	 d = int(input("Enter the marks in fourth subject: "))

	 e = int(input("Enter the marks in fifth subject: "))

	 total = a+b+c+d+e

	 avg = total/5

	 print("Average marks: ",avg)

Test Sheet–2
(Based on chapters 5 to 10)

A.	 Choose the correct option.
	 1. b.	 2. a.	 3. a	 4. a.	 5. b.
	 6. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
	 Question: Which of the following is not a problem solving technique? 
	 a. Mind Map 		  b. Flowchart 
	 c. Algorithm 		  d. None of these
	 Ans. d.
	 7. a.	 8. b.	 9. a.	 10. d.	 11. a.	 12. b.
B.	 Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1. 	 2. 
	 3. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
	 �  Question: A Mind Map allows us to organise ideas, thoughts or concepts and their relationship 

in a graphical manner. 
	   Ans. 
	 4. (This question was printed incorrectly in the book, please correct this question in your textbook.) 
	   Question: Interpreter translates and executes one statement at a time. 
	   Ans.  
	 5. 	 6. 
	 7. 	 8. 
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C.	 Answer the following questions:
	 1. Rules for writing HTML tags are:
	   a. Container tags should always be closed properly.
	   b. Values given to the attributes should be enclosed within the double quotes.
	   c. Tag name should not contain spaces.
	   d. There should be no spaces between < and > in a tag.
	   e. Tags must be nested correctly.
	 2. The key features of Skype are as follows:
	   a. Skype translates the conversation in real-time if the person is talking in a different language.
	   b. It is a safe way to have conversation with people without any interruption.
	   c. You can share your screen to train someone.
	   d. It has Live Subtitles option. This helps a hearing-impaired person to keep up with the call.
	 3. �RSS feed fetches the updated web feed or newly published information from the website/

blog directly to you. So, you do not have to search for updated information again and again.
	 4. �An algorithm is a set of steps in a sequential manner to solve a problem or to complete a task. 
	 5. �A language translator is a software that converts a high-level language program into a machine 

language.
	 6. Data types specify the type of value a variable can contain.
	 7. IDLE stands for Integrated Development and Learning Environment.
	 8. �Intelligence refers to the ability to think, to learn from previous experience, to solve complex 

problems and to adapt new things and environment.




